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EZ-USB™ FX2LP GPIF 入門  
  

About this document 

Scope and purpose 

FX2LP汎用プログラマブル インターフェース (GPIF) は、外部インターフェースが必要とするデータと制
御信号を生成する独立のハードウェア ユニットを提供します。GPIFは、GPIFのレジスタへの CPU読み
出しと書き込みを使用してデータを移動します。本アプリケーション ノートは、GPIFクロックを 2、
4、7で分周する簡単なデザインを設計することで GPIFユニットと GPIF Designerというグラフィカル設
計ツールを紹介します。このインターフェースを設定と管理するには、たった 3行の Cコードだけが必
要です。また本書は、USB接続機能を GPIF設計に実装する方法をデモする例を含んでいます。 

関連プロジェクト 

あり 

ソフトウェア バージョン 

Keil uVision 2、GPIF Designer 

関連したアプリケーション ノート 

すべてのアプリケーション ノートの一覧を表示するには、ここをクリックしてください。 

更にサンプル コードをお求めでしょうか? 以下をご参照ください。 

USB Hi-Speedサンプル コードの総合リストは、このページをご覧ください。 
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1 はじめに 
USB 2.0の 480Mbpsの信号レートでは、コントローラ チップが高速データを内外に移動することを必要
とします。EZ-USB™ FX2LPGPIFは独立したハードウェア ユニットを備えています。CPUはこのハードウ
ェア ユニットをセットアップし、USBエンドポイント FIFOから／へ直接転送されたデータを外部イン
ターフェースに移動します。外部インターフェースは RAM、FIFO、または別のプロセッサです。従っ
て、CPUはデータを移す必要がなく、設定された後、データが GPIFハードウェア チャネルを介して流
れる時に CPUは単にフラグと割込みを監視するだけです。 

拡張 IDE (EIDE - 高速 ATAまたは高速 IDEとも呼ばれる) ／ATAパケット インターフェース (ATAPI) プリン
タ、パラレル ポート (IEEE P1284)、Utopiaなど、GPIFを使用してさまざまなプロトコルを実装できま
す。本アプリケーション ノートは FX2LP GPIFのアーキテクチャと実装について説明します。本書はア
プリケーションの使用モデルとデバッグ処理方法を説明し、GPIFの概念を例を用いて紹介および補足し
ます。 
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2 FX2LPアーキテクチャの概要 
EZ-USB FX2LPは、USB2.0の最大帯域幅に対応するように設計された柔軟な USB 2.0ペリフェラル コント
ローラです。FX2LPは GPIFを提供して外部デバイスとの高速なパラレル インターフェースを実装する
ことで USBスループットを最適化します。GPIFは FX2LPエンドポイント FIFOと GPIFインターフェース
の間でデータを移動します。以下の節は、FX2LPのあり得る設定可能なモードを示すことで FX2LPアー
キテクチャを簡単に説明します。 

2.1 ポート モード 
FX2LPは、モードの設定に応じて異なる役割を果たす 24本のインターフェース ピンを備えています。
「ポート」モードでは、これらは汎用 I/Oピンであり、GPIFは非アクティブになっています (Figure 1)。 
 

Host (PC)

USB
SIE
FIFOs 8051

Pins

FX2LP

PA[7:0]
PB[7:0]
PD[7:0]

 

Figure 1 ポート モードでの FX2LP 

2.2 スレーブ FIFOモード 
スレーブ FIFOモードでは、専用 FX2LPロジックは USBエンドポイント FIFOを外部 FIFOコントローラ
に接続するために制御とデータ信号を提供します。データバスおよび FIFO選択入力に加えて、インタ
ーフェースは RD、WRおよび FIFOフラグなどの通常の FIFO信号を提供します。「AN63787 - EZ-USB 
FX2LP GPIF and Slave FIFO Configuration Examples Using 8-bit Asynchronous Interface」を参照してくだ
さい。 
 

Host (PC)

USB
SIE
FIFOs

8051

Pins

CLK
RD,WR
FLAGS

ADDR[1:0]
ControlFX2LP

SlaveFIFO
 logic

DATA[15:0]

 

Figure 2 スレーブ FIFOモードでの FX2LPピン 

http://www.cypress.com/?rID=45850
http://www.cypress.com/?rID=45850
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2.3 GPIF自動モード 
GPIFがアクティブになった時、インターフェースのピンはマスター デバイスとして機能し、RAMや
FIFOまたは外部プロセッサなどの外部ペリフェラルを制御します。GPIFは自動と手動という 2つのサブ
モードで動作します。自動モードでは、データはエンドポイント FIFOから外部インターフェースに直
接流れます。8051プロセッサはこのインターフェースを設定し、監視しますが、FIFOデータに直接ア
クセスしません (Figure 3を参照してください)。 
 

Host (PC)

USB
SIE
FIFOs

8051 Pins

IFCLK
CTL[5:0]

ADDR[8:0]

RDY[5:0]
Gstate[2:0]FX2LP

G
PIF DATA[15:0]

 

Figure 3 FX2LP - GPIF自動モード 

8ビット非同期インターフェースと GPIF自動モードを使用してサイプレス CY7C1399B SRAMを FX2LPに
接続する方法は「AN57322 - Interfacing SRAM with FX2LP over GPIF」を参照してください。 

2.4 GPIFモード - 手動 
手動モードでは、8051プロセッサは GPIFのレジスタの読み出しと書き込みによりインターフェースか
ら／へのバイト読み書きを行います (Figure 4)。GPIF手動モードのサンプルは例 3: シングル ワード読み
出し／書き込みトランザクションを使用で説明します。 
 

Host (PC)

USB
SIE
FIFOs

8051 Pins

IFCLK
CTL[5:0]

ADDR[8:0]

RDY[5:0]
Gstate[2:0]FX2LP

G
PIF DATA[15:0]

 

Figure 4 FX2LP - GPIF手動モード 

http://www.cypress.com/?rID=39392
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3 汎用プログラマブル インターフェース 

3.1 GPIFの概要 
GPIFのコアの中にはプログラム可能なステート マシンがあります。これは、8ビットまたは 16ビット
双方向データ バスを制御し、最大 6本の制御 (CTL) と 9本のアドレス (GPIFADR) 出力を生成します。ま
た、6本の外部 READY入力と 2本の内部 READY入力を受け入れて分岐の条件を判定します。4つのユー
ザー定義の波形ディスクリプタはステート マシンを制御します。8051の制御プログラムは 4つの波形
から特定の時点でアクティブにする 1つの波形を選択します。  

それぞれの GPIF波形ディスクリプタには、S0～S6と名付けられた最大 7ステートがあります。事前定
義の S7は IDLEステートとなっています。各ステートで、以下のことを実行するように GPIFをプログラ
ムすることができます。 

• CTL出力のいずれかまたはすべてをドライブ HIGH、ドライブ LOW、またはフローティングにする 
• 8ビット／16ビット データ バスをサンプリング／駆動する 
• GPIFアドレス バスの値をインクリメントする 
• FIFOポインタをインクリメントする 
• 8051への GPIF波形割り込みをトリガーする 

どのステートの分岐決定も、以下のオプションから取られた 2信号の論理 AND、OR、または XORの結
果と見なされます。 

• 6本の READY入力ピン 
• 1つの FIFOフラグ 
• 1つの内部 RDYフラグ 
• 1つの内部トランザクションカウント期限切れフラグ 

2つの選択した信号の論理結合は次のステートを決定します。あるいは、プログラム可能な遅延時間が
経過すると、ステート マシンが次のステートに進みます。この遅延時間は 1～256クロック サイクルで
す。 

サンプルとブランチのステートを「判定ポイント」と呼びます。決定点無しのステートは 1クロック間
持続した後、次のクロックで自動的に次のステートに遷移します。 
 

IDLE

Non-
Decision

PointCPU_TRIG Decision 
Point

A(func)B is TRUE

A(func)B is FALSE

(func) = AND, OR, XOR

State 0 State 1

State 7
 

Figure 5 GPIFステート マシンの構文 

Figure 5に示すステート マシンは以下のように表現できます。 

1. IDLEステートから始まり、CPU_TRIG信号がアサートするのを待ちます。  
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2. CPU_TRIGがアサートすると、ステート 0に遷移します。ステート 0では、幾つかの制御信号出力を
アクティブにしたり、データを移動したり、アドレス バスをインクリメントしたりできます。この
ステートは次のクロックまでしか持続しません。その後、決定がないため、無条件でステート 1に
遷移します。 

3. Aと Bの 2信号の論理結合が FALSEから TRUEになるまでステート 1を持続させます。例えば、
READY信号が有効になる、またはカウントが終了するまでステート 1を持続させるために、Aを
READY入力に、Bをカウンタの終了値に選択します。ステート マシンは論理演算子 ORを使用し、
READYまたはターミナル カウントのいずれかの条件が発生すると、ステート 1から移行します。  

4. 条件が TRUEになると、IDLE状態に戻ります。これによって、ステート マシンが停止します。  

3.2 物理的な相互接続 
GPIFの相互接続は、8または 16ビット データ バス、1つのアドレス バス、制御出力、レディー入力を
含んでいます (Figure 4)。デバッグのために、現時点の GPIFステート マシンを示す 3本の GSTATE出力
も含んでいます。本節では、これらの信号を詳しく説明します。  

3.2.1 IFCLK 
IFCLK (インターフェース クロック) は、すべての GPIF動作用のリファレンス クロックです。これは入力
または出力信号であり、立ち上がりまたは立ち下がりエッジをアクティブ エッジに選択できます。入力
信号としては、IFCLKは 5MHz～48MHz範囲の外部クロックにより駆動できます。出力信号としては、
IFCLKは FX2LP内部クロックにより 30MHzまたは 48MHzのいずれかで駆動できます。外部ペリフェラル
がより遅いクロックを必要とする場合、CTLラインのいずれかは FX2LP内部クロックを使ってトグルで
きます。最初の例では、GPIFクロックは 2と 4で分周され、信号が 2本の CTL出力により出力されま
す。より高い除数が必要とされる場合、GPIFステートは次のステートに進む前に、プログラム済みのク
ロック数 (1～256) をカウントするようプログラムすることができます。  

3.2.2 GPIFADR[8:0] (出力のみ)  
GPIFは GPIFADR[8:0]を駆動してアドレス ラインを必要とするペリフェラルにアドレス ラインを提供しま
す。これらの出力はどの GPIFステートでも保持するかインクリメントすることができます。  

3.2.3 FD[15:0] (双方向)  
データ バスは、FX2LPのエンドポイント FIFOと外部ペリフェラル間で転送されるペイロード データ用
のパイプです。これは 8ビットまたは 16ビット インターフェースとして動作するように設定でき、シ
ステムが必要とする場合にトライステートにすることができます。16ビット モードでは、FD[7:0]はエ
ンドポイント FIFOの最初のバイトを表し、FD[15:8]は 2番目のバイトを表します。  

3.2.4 CTL[5:0] (出力のみ)  
制御出力は、読み出し／読み込みストローブ、イネーブル、分周されたクロックなど外部ペリフェラル
が必要とする信号を提供します。 

3.2.5 RDY[5:0] (入力のみ)  
レディー入力信号は、FIFO状態フラグや使用可能なデータなど外部ペリフェラルからの状態情報を提供
します。GPIFはこれらの信号を使用して決定点を検証することができます。  

3.2.6 GSTATE[2:0] (出力のみ)  
デバッグ出力信号は、GPIF波形として実行されるステートを表します。これらはデバッグのためにロジ
ック アナライザに接続されています。 
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4 GPIFアプリケーションの作成 
本節では、GPIFアプリケーションを作成する手順を説明します。 

4.1 GPIFインターフェースの設計 
GPIFの相互接続を設計するために、FX2LPと外部ペリフェラル デバイスとのインターフェースを理解す
る必要があります。FX2LPデータシートとテクニカル リファレンス マニュアルはインターフェースを
定義するために使用されます。GPIFの設定方法は以下の決定に依存します。  

• 8ビットか 16ビット データ パス? 

この判断は、主にペリフェラルが提供するデータパス サイズに左右されます。16ビットのデータパス
を持つ場合、物理インターフェースを介して帯域幅を最大限にするために 16ビット幅を使用します。  

16ビット データ パスでは、データ バスを接続する際にエンディアンネス (バイト オーダー) とビットの
番号付けも考慮する必要があります。  

• 外部か内部インターフェース クロック? 

この決定は、ペリフェラル独自の動作モードに関してはペリフェラルがどのように柔軟であるかに左右
されます。例えば、外部の 30MHzまたは 48MHzクロック入力を受け入れられた場合、内部 GPIFクロッ
クはペリフェラル クロック入力に接続することができます。  

• アドレス ラインが必要? 

ペリフェラルが任意のレジスタまたはメモリ位置が読み出し／書き込みサイクルの動作中にアドレス指
定されることを必要とした場合、GPIFADR[8:0]を使用できます。 

• 制御ライン 

CTL[5:0]からの GPIF制御出力を指定します。ペリフェラルは動作中に読み出し／書き込み信号、チップ
選択やその他の制御入力を必要とすることがあります。必要な制御信号を決定して、CTL[5:0]を適切に
割り当てます。GPIF Designerツールでは、明確化のためにこれらの信号に名前を付けることができま
す。例えば、WR#は CTL[0]、RD#は CTL[1]の名前です。 

• ステータス (RDY) ライン 

読み出し／書き込みサイクル中に監視する必要のあるステータス信号の数を判定します。これらを識別
して、RDY[5:0]を適切に割り当てます。GPIF Designerは、設計に合わせてこれらの信号に名前を付ける
ことができます。  

• インターフェースのタイミング 

入力と出力が割付けられた後、GPIFアプリケーションの主な部分はインターフェースのタイミングと見
なされるタイミング波形を設計することです。 

Note: すべての FX2LPパッケージ タイプは GPIFインターフェースの完全な信号セットを提供す
るとは限りません。例えば、100ピンと 128ピン FX2LPパッケージはすべての 6本のレデ
ィー入力 (RDY[5:0]) と制御出力 (CTL[5:0]) を提供しています。56ピン パッケージは 2本の
RDY信号 (RDY[1:0]) と 3本の CTL信号 (CTL[2:0]) を提供しています。  

http://www.cypress.com/?rID=38801
http://www.cypress.com/?rID=38232


  

Application Note 9 of 51 001-75653 Rev. *C  
  2021-06-02 

EZ-USB™ FX2LP GPIF入門 
  
GPIFアプリケーションの作成 

  

4.2 ファームウェア フレームワークの使用 
GPIF Designerを使用してインターフェース信号と波形を作成する際に、Keil社の統合開発環境 (IDE) を使
用して制御ファームウェアを書きます。新規の FX2LPファームウェア プロジェクトを開始する際に、サ
イプレスが提供するファームウェア フレームワーク ベースの Keil uVision2プロジェクトで開始するのは
最も容易な方法です。FX2LP開発キット (DVK) 同梱のサンプル ファームウェアはフレームワークに基づ
いたものです。これらのいずれかで開始する、または Keilプロジェクトを新しいサブディレクトリにコ
ピーして修正することができます。これにより、クリーンなファームウェア ベースで開発を開始できる
ようになります。ファームウェア フレームワーク プロジェクトで開発を開始するもう 1つの利点は、
USBの低レベル プロトコル コードが既に書かれているため、ユーザーはアプリケーション コードに集
中することができます。詳細は fw.cファイルおよび開発キットの資料を参照してください。  

GPIFアプリケーションには 2つの主なコンポーネントがあります。 

• GPIFを設定し、GPIF転送を起動するファームウェア。このファームウェアは USBエニュメレーショ
ンやエンドポイント設定など他のタスクも実行します。  

• 物理的なバス タイミングとデータ フローを実装する GPIF波形ディスクリプタ。 

ファームウェアは次の 5ファイルから構成されています: fw.c、periph.c (このファイル名が変更可能)、
dscr.a51、ezusb.lib、usbjmptb.obj。これらのファイルは Keil uVision 2ファームウェア フレームワーク プ
ロジェクトを格納しています。  

2番目のコンポーネントは、GPIF波形を定義し GPIFユニットを初期化するためのコードを格納している
Cソース ファイル (gpif.cなど) です。インターフェースをグラフで定義した後、GPIF Designerツールは
この Cファイルを生成します。これにより、GPIFユニット内の各々のレジスタとビットを知ることが不
要になります。こちらから GPIF Designerユーティリティをダウンロードできます。 

4.3 GPIF Designerを使用して波形を改善 
GPIF Designerは、インターフェースの物理的なバス タイミングを実装する GPIF波形ディスクリプタを
含む Cコードを生成します。GPIF Designerは複数の波形を実装できます。それらは 4種類に分けられて
います: シングル書き込み、シングル読み出し、FIFO書き込み、FIFO読み出し。CPUは GPIFWFSELECT
レジスタに書き込むことでどの波形を使用するかを制御します。各ディスクリプタは 32バイトの長さ
で、内蔵メモリ空間内の特殊な GPIF波形ディスクリプタ領域に保存されています。GPIF Designerツー
ルは、これらのディスクリプタを実装して使用するのにすべての必要な Cコードを生成するため、これ
らのディスクリプタを「ブラック ボックス」 (black box) として見なすことができます。 

GPIF波形をステート マシンとして作成することができます。動作用の 7ステートまたは間隔 (S0～S6) 
およびトランザクションを終了するための自動 IDLEステート S7があります。 
 

 

Figure 6 ステートから構築された GPIF波形 

Figure 6には、GPIFステート遷移に分けられた簡単な波形の 1例を示します。 

http://www.cypress.com/?rID=14321
http://www.cypress.com/?rID=14448
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5 例 1: GPIFクロックを 2または 4で分周 
まず、GPIFクロックを 2または 4で分周して、分周したクロック信号を CTL[0]と CTL[1]に出力するため
のステート マシンを設計して見ましょう。これで、USBエンドポイント FIFOに関する高度な機能を紹
介する前に、GPIF Designerツールの基礎知識を提供します。この例では USBは使用しないため、ファー
ムウェア フレームワークは必要ありません。  

1. 本アプリケーション ノートに添付された FX2LP source code and GPIF project files.zipファイルを解凍し
て保存します。FX2LP Source code and GPIF project files\Firmware\GPIF Clock Dividerに移動します。こ
のフォルダを右クリックし、Propertiesをクリックします。「Read-only...」オプションが選択され
ている場合、そのチェックボックをオフにします。サブフォルダに変更を適用するために OKをクリ
ックします。 

このフォルダから、GPIF_Clock_Divider.uv2をダブルクリックして Keil uVision2 IDEを起動します。こ
れには、GPIF情報だけを持っているスケルトン GPIFプロジェクトがあります。main.cをダブルクリ
ックして開きます。すると、3行のコードだけで GPIF動作を開始できることが分かります。 

WORD g_data; 

GpifInit(); 

XGPIFSGLDATLX=g_data;// Start transfer 
 

 

Figure 7 スケルトン GPIF Keilプロジェクト 

このコードをそのままコンパイルすると、GPIF Designerによって生成された GPIF Cが含まれていない
ため、リンカー エラーが表示されます。このファイルは GpifInit()関数および波形テーブル データを格
納しています。次に、このファイルを作成して見ましょう。 
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2. GPIF Designerを起動し、File > Newを選択すると、下図のようなウィンドウが表示されます。 
 

 

Figure 8 GPIF Designerのスタートアップ ウィンドウ 

3. FX2LP開発キット基板を使用してサンプルをテストするために、CY FX2 (128pin) を選択して OKをク
リックします。これにより、ブロック図ウィンドウが表示されます。 

 

 

Figure 9 GPIF Designerのブロック図 

4. ブロック図の最上部で、Clk 48 MHzテキスト ボックスを右クリックして GPIFクロックを設定しま
す。このプロジェクトでは、デフォルト設定のままにします。 
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Figure 10 IFCLKのデフォルト設定 

5. ADR (アドレス) ラベルを右クリックします。この例ではアドレス バスを使用しないため、Disable All
をクリックできます。これにより、ブロック図内のアドレス ワイヤは暗くなります。 

 

 

Figure 11 アドレス ラインの無効 

6. RDY (レディー) ラベルを右クリックして 6本の RDY入力を設定します。この例では RDY入力は未使
用のため、すべてを無効にすることができます。RDY5を選択解除するために、まず Subst TC for 
RDY5を選択解除します。 

 

 

Figure 12 RDY入力の無効 
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7. CTL (制御) ラベルを右クリックして 6本の CTL出力を設定します。これらを下図のように設定しま
す。 

 

 

Figure 13 CTL出力の設定 

テキスト ボックスに入力して 2つの出力名を divby2と divby4に変更します。信号を名付けると、すべ
ての GPIF Designer画面でラベルが更新され、信号が識別しやすくなるため (例えば、CTL1でなく
divby4)、これは良い実践方法です。これで、ブロック図がもっと簡単になります。 
 

 

Figure 14 クロック分周器のブロック図 



  

Application Note 14 of 51 001-75653 Rev. *C  
  2021-06-02 

EZ-USB™ FX2LP GPIF入門 
  
例 1: GPIFクロックを 2または 4で分周 

  

8. 2本の波形を描くための Single Writeタブを選択します。タブ名を右クリックし、Select Tab Label
を選択し、名前を Dividerに変更します。Figure 15のように空の波形編集画面が表示されます。  

 

 

Figure 15 空の波形編集画面 

9. ステート マシンには IDLEというステートがあります。ステートを追加するために、divby2および
divby4と名付けられた CTLバンドのどちらかをクリックします。Dataバンドをクリックしてステー
トを追加することもできますが、この設計ではデータ バスを使用していません。divby2バンドで
は、2番目の垂直の点線をクリックします。 

 

 

Figure 16 最初の波形遷移 
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三角形が表示されて、GPIF Designerがステート s0を追加し、s0の始まりと終わりで divby2出力をト
グルしたことを示します。 

10. これで、次の 3本のクロック遷移点線ごとに divby2波形をクリックします。これにより、クロック
の divide-by-2波形が作成されます。 

11. divby4波形では、2番目と 4番目の線をクリックします。画面が Figure 17のようになります。 
 

 

Figure 17 Div by 2と Div by 4波形 

Note: どの三角形も右クリックして論理ステートを変更することで信号極性を修正することが
できます。三角形を水平にドラッグしてステートを 1クロックより長くすることもできま
す。  

Figure 17のステート マシンは開始した時、各立ち上がりエッジで s0、s1、s2、s3ステートの順番で遷
移して IDLEステートで停止します。そのように繰り返す必要があります。つまり、s3は常に s0に戻っ
て分岐しなければなりません。このために、Statusラインで「決定点」を追加します。  
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Figure 18 最初の決定点 

12. s2と s3ステート間の Statusバンドをクリックします。すると、決定点としてダイヤモンド形が追加
され、決定を設定するためのウィンドウが表示されます。無条件分岐を行うために、最上部のドロ
ップダウン リストから任意の 2本の論理信号およびそれらに任意の論理演算子を選択できます。S0
への遷移のために THENと ELSE両方の条件を指定する必要があります。即ち、無条件で S0に分岐し
ます。LOOP (Re-Execute)チェックボックスは、ステートに遷移するたびにステート条件を再アサー
トするのに使用されます。s3には「変更されるまでこのステートを持続させる」ループがないた
め、チェックを入れないことができます。  

クロック波形は s3に斜線を表示して、決定ステート (decision state) のクロック数が未定であることを
示します。 理由は、クロック数が分岐条件が満たされる時点に因るためです。  

GPIF Designerは設計で使用するすべてのパラメータを追跡してそれに応じて選択項目を更新します。
例えば、ステート s4を追加すると、これが自動的に GOTO選択項目に追加されます。 

重要な注意: 決定点はそれが発生するステートの始まり (終わりではない) に置きます。この理由で、
ダイヤモンド形は s3の始まりに置いてあります。  

13. GPIF Designerプロジェクトを保存するために、File > Save Asを選択し、Keilプロジェクト フォルダ
に Div_2_4.gpfとして保存します。波形を修正するために後でファイルを再び開くことができます。
GPIF Designerが生成した Cコードを保存するために、Tools>Export to GPIF.c fileを選択し、Keilプロ
ジェクト フォルダに GPIF_div_2_4.cとして保存します。Div_2_4.gpfと GPIF_div_2_4.cファイルは
FX2LP Source code and GPIF project files\GPIF Clock Divider\GPIF_div_2_4フォルダに用意されていま
す。それらを直接使用してプロジェクトをテストすることができます。 

14. 最後の手順は GPIF Designerの Cファイルを Keilプロジェクトに含めることです。Sources Group 1を
右クリックして Add files…を選択します。Keilプロジェクト フォルダに移動してそれに
GPIF_div_2_4.cファイルを入れます。  
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Figure 19 GPIF Designerの Cファイルを Keilプロジェクトに追加 

15. プロジェクトをコンパイルします。Keil IDEはファイルをコンパイルしてリンクさせた後、ロード モ
ジュールをサイプレス USBコントロール パネル ローダと互換性があるフォーマットに変換するため
に「hex2bix」ユーティリティを呼び出します。  

以下のように設計を FX2LP開発基板上に試すことができます。 

a) EEPROM SELECTスイッチをオフの位置 (下) にします。すると、FX2LPの搭載 USBコード ローダが
有効になります。 

b) FX2LP基板を PC USBポートに接続します。これが初めての場合、USBドライバをインストールす
るようポップアップ メッセージが表示されます。C:\Cypress\USB\CY3684_EZ-
USB_FX2LP_DVK\1.0\Drivers\cyusbfx1_fx2lpに移行し、Windows OSに応じたフォルダを選択しま
す。Windows Device Managerにてドライバのインストールを確認します。 
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Figure 20 サイプレス USBローダ ドライバのインストールが完了 

16. C:\Cypress\Cypress Suite USB 3.4.7\CyUSB.NET\bin\CyControl.exeから USBコントロール パネルを起動
します。 

17. FX2LP基板および他の接続された USBデバイスが左パネルに表示されます。FX2LP基板だけを表示す
るために、右パネルの Device Class Selectionタブをクリックし、Devices served by the CyUSB.sys 
driver (or a derivative)アイテムを除いてすべてのチェックボックスをオフにします。左パネルが
Figure 21のようになります。 

 

 

Figure 21 USBコントロール センターに表示された FX2LP基板 

18. これで、Keilのコンパイルされた HEXファイルを基板にロードできるようになります。EZ-USBエン
トリーをハイライトし、Program FX2 > RAMを選択します。 

 

 

Figure 22 新しいデバイス コードを RAMにロード 
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19. FX2LP開発基板上の RESETボタンを押します。すると、USBローダが有効になります。 
20. Keilプロジェクト フォルダに移動して Keilコンパイラの結果である GPIF_Clock_Divider_Proj.hexファ
イルを選択します。 

21. P2ピン 11 (CTL0=divby2) と P2ピン 10 (CTL1=divby4) をプローブ (probe) します。波形が Figure 23の
ようになります。 

 

 

Figure 23 2と 4で分周された GPIF 48MHzクロック 
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6 例 2: GPIFクロックを 7で分周 
1. 例 1を修正することで任意のクロック分周器を選択でき、奇数の除数を使用しても構いません。 
2. GPIF Designerを起動し、File > Newを選択して新規の GPIFプロジェクトを作成します。CY FX2(128 

pin) デバイスを選択します。 
3. 上記のように ADRと RDY信号を除去し、2本の CTL信号の名前 CTL0と CTL1をそれぞれに divby7と

stbに変更します。残りの 4本の信号を無効にします。 
 

 

Figure 24 2本の出力「Divide by 7」と「Strobe」 

4. Single Writeタブを選択します。divby7バンドでは、最初の三角形から 3クロック後にステート遷移
の三角形を置き、それから 4クロック後にもう 1つの三角形を置きます。stbバンドでは、その始ま
りから 1クロック後に三角形を置きます。最初の三角形を右クリックして HIにセットし、2番目の
三角形を LOにセットします。すると、s0で負極性パルスが正極性パルスに変換されます。波形が
Figure 25のようになります。 

 

 

Figure 25 「Divide by 7」と「Strobe」の波形 

最後に、s2の終わりの 1クロック前に対応する位置で Statusバンドのクロック ラインをクリックしま
す。すると、決定点と新しいステート s3が作成されます。決定点を S0に無条件で分岐するよう設定す
る必要があります。THEN GOTOと ELSE GOTOの両ステートが S0と選択されたため、IF条件は任意とな
り、ドロップダウン リストからどれも選択できます。  
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Figure 26 S0に無条件に分岐 

 

 

Figure 27 最終の「Divide-by-7」波形 

5. このファイルを Keilプロジェクト フォルダに GPIF_div_7.cとしてエクスポートします (Tools>Export 
to GPIF.c)。プロジェクトファイルを Div_by_7.gpfとして保存します (File>Save As)。Div_by_4.gpfと
GPIF_div_7.cファイルは FX2LP Source code and GPIF project files\GPIF Clock 
Divider\GPIF_div_7フォルダにも用意されています。それらを直接使用してプロジェクトをテス
トすることができます。 

6. Keil Filesタブで、Source Group 1を右クリックし、Add Files…をクリックして GPIF_div_7.cをプロジ
ェクトに追加します。これで、2つの GPIF波形ファイルがあるため、Keilコンパイラはどのファイ
ルを使用するかを知る必要があります。ビルドから何らかのソース ファイルを無効にするために、
それを右クリックして Options for file…を選択し、Include in Target Buildチェックボックスをオフ
にします。プロジェクトに 2つ以上の GPIF.cファイルがある場合、チェックボックスがオンになっ
ているものが 1つだけであることを確認します。 

7. Project > Rebuild All Target Filesを選択して再びコンパイルします。 
8. FX2LP開発基板上の RESETボタンを押します。すると、USBコード ローダが元に戻ります。  
9. 上記のように USBコントロール センターを使用して新しくコンパイルされた

GPIF_Clock_Divider_Proj.hexファイルをロードします。  
10. P2ピン 11 (CTL0=divby7) をプローブします。画面が Figure 28のようになります。 
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Figure 28 最上部: 「Divide by 7」；最下部: 「stb」；信号は 1クロック幅 (参照のため) 

div-by-87などのようなより高い除数のためには、何をする必要があるのでしょうか? GPIF Designerで
は、ステートの期間を 1～256クロックに設定できます。Statesバンドで任意のステートをクリックしま
す。Figure 29のようなウィンドウが表示されます。Set State Durationをクリックし、クロックの数を
設定します (Figure 30)。ステートのクロック数を手動でセットすると、タイミング図のクロック ライン
はもはやステートのクロック数を示さなくなります。  
 

 

Figure 29 s2のプロパティ  

 

 

Figure 30 1～256クロック サイクルを選択 
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7 例 3: シングル ワード読み出し／書き込みトランザクション
を使用 

この例では、サイプレス CY7C4265-15AXCの外部 FIFOを介して FX2LPデータをロープします。GPIF手動
モードを使用し、16ビット データ バスを介してシングルの読み出し／書き込み GPIFトランザクション
を実装します。FIFO書き込み動作はスコープまたはロジック アナライザで監視できますが、読み出しの
テストの場合は、外部 FIFOチップを FX2LP開発基板に接続する必要があります。 

この例の場合、開発キット同梱の試作用基板を使用して外部 FIFOを FX2LP開発基板に搭載します。外
部 FIFOの完全なハードウェア仕様については、CY7C4265データシートをダウンロードして参照してく
ださい。FX2LP開発基板と試作基板を接続する際のピン配置リストおよび外部 FIFO試作用基板の完全な
回路図は、本アプリケーション ノートに添付された「Hardware」フォルダにあります。 

シングル読み出し／書き込みトランザクションは FX2LPと外部ペリフェラルの間で 1データ バイトまた
は 1データ ワードを転送します。これらのトランザクションは FIFO読み出し／書き込みトランザクシ
ョンより実装しやすく、最初に実装することが推奨されています。GPIF開発サイクルの最初にこの段階
を実装することで、より複雑な設計に進む前にシステムのすべてのエリア (ハードウェア、ファームウ
ェア、ソフトウェア) を検証することができます。物理的な相互接続と基本的なデータ移動を検証した
後、完全な設計に進むことが容易になります。 

7.1 FIFO読み出し／書き込みトランザクションを実装  
シングル トランザクションを実装した後、次の手順としては、より高い帯域幅を達成するために GPIF 
FIFO読み出し／書き込みトランザクションを実装します。最初に FIFO書き込み波形を実装すること
で、完全なループバック ソリューションをテストする際に発生し得る問題を回避できます。これを実現
できないなら、書き込み、読み出し、または両方から問題を切り分けることが困難になります。  

7.2 必要に応じて最適化  
GPIF波形を生成する際、初期に物理的バスの HIGH時間を設定することがあります。設定した場合、ペ
リフェラルが必要としたタイミング パラメータを満たしながら各 GPIFトランザクションのサイクル時
間を削減することができます。この段階では、設計を改善してファームウェア コード効率と全体的なフ
ァームウェア コード フローを改善させることができます。 

Figure 31は GPIF設計フロー図で本節の手順をまとめています。 

http://www.cypress.com/?rID=34595
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Figure 31 GPIF設計フロー図 

7.3 FIFOを FX2LP GPIFインターフェース 
Figure 32は FX2LPと外部 FIFOの接続を示します。FX2LPは双方向バス FD[15:0]を使用して外部 FIFOか
ら／へデータを読み書きします。FIFOデータ バスは、その出力データ バス Q[15:0]と入力データ バス
D[15:0]を接続することで双方向にします。この例では、USB BULK転送を使用して FIFOデータを読み書
きします。これらの転送は、Suite USB 3.4 - Visual Studio向けの USB開発ツール同梱の USBコントロ
ール センター ユーティリティを使用して実行できます。 

Table 1は GPIFの相互接続を詳しく説明します。CTLと RDYピンは最小の FX2LPパッケージ (56ピン) と
互換性があるように割り当てられています。 

http://www.cypress.com/?rID=34870
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Figure 32 GPIFの外部同期 FIFOとの接続 

Table 1 FX2LP GPIF信号の CY7C4265-15AC信号への割り当て 

FX2LPの
GPIF信号 

CY7C4265-
15AXCの信号 

説明 

IFCLK WCLK、RCLK IFCLKは、外部 FIFOの書き込みと読み出しクロック入力 (WCLK、RCLK) に
接続。WEN#がアサートされた時、データは WCLKの各立ち上がりエッジ
で外部 FIFOにクロック入力。同様に、REN#と OE#がアサートされた時、
FIFOは RCLKの各立ち上がりエッジで Q[15:0]にデータを出力。外部 FIFO
は最大 66.7MHzまでの入力クロック周波数を受け入れられるため、30MHz
または 48MHzの入力 IFCLK周波数に対応可能。注: ハッシュ マーク (例え
ば、OE#) はアクティブ LOWを意味  

FD[15:0] D[15:0]、
Q[15:0] 

ワード幅の動作のために、GPIFデータ バス FD[15:0]は外部 FIFOの入力デ
ータ バス D[15:0]に接続。FX2LPが FIFOデータ内容を読み戻せるために、
外部 FIFOの出力データ バス Q[15:0]も GPIFデータ バスに接続。2本の単
方向 FIFOデータ バスが互いに接続されているため、GPIFはバス競合が発
生しないように OE#信号を制御する必要。特に、FX2LPがデータ バスを駆
動している時、OE#は LOWになってはならない。その場合、FX2LPと FIFO
がデータ バスを同時に駆動するためバス競合が発生する  

CTL0 WEN# CTL0は外部 FIFOの書き込みイネーブル ピン WEN#に接続。GPIFが WEN#
を LOWに維持している間、データは WCLKの各立ち上がりエッジで外部
FIFOに書き込まれる  

CTL1 REN# CTL1は外部 FIFOの読み出しイネーブル ピン REN#に接続。GPIFが REN#と
OE#を LOWに維持している間、FIFOは RCLKの各立ち上がりエッジで新し
いデータを Q[15:0]に駆動  

CTL2 OE# CTL2は外部 FIFOの出力イネーブル ピン OE#に接続。REN#と OE#が LOW
に維持されている間、FIFOは RCLKの各立ち上がりエッジで新しいデータ
を Q[15:0]に駆動 
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FX2LPの
GPIF信号 

CY7C4265-
15AXCの信号 

説明 

RDY0 EF# RDY0は外部 FIFOの EMPTYフラグ EF#に接続。FIFOは空の時、このフラグ
をアサート (LOWにする)。READY信号が各 GPIF分岐ステートでテストで
きるため、GPIFは外部 FIFOから読み出している間にこの信号を使用して
データ転送を調整することが可能  

RDY1 FF# RDY1は外部 FIFOの FULLフラグ FF#に接続。FIFOは満杯の時、このフラ
グをアサート (LOWにする)。GPIFは外部 FIFOに書き込まれている間にこ
の信号を使用してデータ転送を調整することが可能  

PA2 RS# PA2は外部 FIFOの RESETピンに接続。PA2は FX2LPの GPIOピンであり、
GPIFロジックの一部ではない。8051コードは PA2を使用して、GPIFデー
タ転送が開始される前の既知のステートに外部 FIFOをリセット  
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8 USBデータ フロー 
USBのエンドポイント 2 OUT (EP2OUT) は外部 FIFOへの GPIF書き込みのソース エンドポイントとして使
用され、エンドポイント 6 IN (EP6IN) は外部 FIFOからの GPIF読み出しのシンク エンドポイントとして
使用されます。USBの INと OUTの方向はホストを中心にしています: 

• EP2OUTは、USBホスト (PC) によって送信されて FX2LPによって受信されたデータ パケットを格納
します。 

• EP6INは、FX2LPによって送信されて PCによって受信されたデータ パケットを格納します。 
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9 GPIFの相互接続を設計 
GPIFの相互接続は最初の例で述べられた手順に従ってセットアップし、本節では簡単に説明します。 

1. サイプレス GPIF Designerツールを起動します。 
2. FX2LP開発基板で使用されたように、File > Newに移動して CY FX2 (128 pin)を選択します。 
3. 外部デバイス ブロックで Un-namedラベルを右クリックしてその名前を CY7C4265-15ACに変更しま
す。 

4. 初期設定ではデータ バスは 16ビットです。この例は 16ビット データ バスを使用します。 
5. ADRラベルを右クリックします。この設計ではアドレス ラインを使用しないため、ブロック図を簡
略化するためにそれらを無効にします。 

6. RDYラベルを右クリックし、Figure 33のように RDY信号を設定します。 
 

 

Figure 33 RDYピンのコンフィギュレーション 

7. CTLラベルを右クリックして、Figure 34のように CTL信号を設定します。 
 

 

Figure 34 CTLピンのコンフィギュレーション 

8. 48 MHz CLKテキスト ボックスを右クリックして、Figure 35のようにクロック特性を設定します。
Invert Clockチェックボックスをオンにします。GPIFは立ち上がりエッジで信号を変更およびサンプ
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リングし、FIFOは立ち下がりエッジで信号を変更およびサンプリングします。この半クロックのオ
フセットにより、インターフェースは十分なセットアップとホールド時間を有します。  

 

 

Figure 35 IFCLKを設定 

ブロック図は Figure 36のようになります。これで、クロックは「nClk 48 Mhz」 (「n」がクロック反転
を示す) とラベル付けられています。  
 

 

Figure 36 FIFOインターフェースを設定 

9.1 シングル ワード書き込み波形 
書き込み波形は FX2LP OUTエンドポイント FIFOから外部 FIFOにデータを移動するように設計されま
す。「FIFO Read」タブを右クリックしてその名前を「Unused」に変更します。「FIFO Write」タブに対
しても同様です。顔面が Figure 37のようになります。 
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Figure 37 波形の画面 

「Tools > Map Waveforms to WFSELECT」を選択します (Figure 38)。 
 

 

Figure 38 波形のマッピング ダイアログ 

「Single Write」波形が「SINGLEWR」に、「Single Read」波形が「SINGLERD」にマッピングするように
してください。これにより、波形を開始する 8051 CPUレジスタと GPIFで名付けられた波形がペアにな
ります。  

Note: 波形のマッピングにより、同じ転送タイプに設定された 1つ以上の波形組を定義すること
ができます。例えば、Single Writeに 2つの異なる波形タイプを使用できます。 

書き込み波形は FX2LP OUTエンドポイントから外部 FIFOにデータを移動するバイト転送を管理しま
す。FIFO書き込み波形を構成するために、まず CY7C4265データシートに記載されている CY7C4265の
FIFO書き込みサイクル タイミングを確認してください。Figure 39は、最下部に GPIFステートを追加し
た書き込みサイクルのタイミング図を示します。  

http://www.cypress.com/?rID=34595
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IDLE S0 S1

 

Figure 39 書き込みサイクルのタイミング図 

書き込みサイクルのタイミング図から Figure 40のステート図を構成します。 
 

S0
WEN#=0
REN#=1
OE#=1
Activate 

Data

S1
WEN#=1
REN#=1
OE#=1

Deactivate 
Data

 S7(IDLE)
WEN#=1
REN#=1
OE#=1

Deactivate 
Data

Initiate

 

Figure 40 シングル ワード FIFO書き込みのステート図 

• シングル書き込み波形では、WEN#を論理 LOWにし、データ バスを駆動することでデータを外部
FIFOに書き込みます。 

• S1では、WEN#は非アクティブ (HIGH) になり、GPIFデータ バスは駆動を停止 (フロート) します。S1
は、IDLEに無条件分岐を強制的に行って波形を終了する決定点のステートです。IDLEステートで
は、動作が発生しません。  
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• 書き込み波形が開始されるたびに、GPIFエンジンは S0、S1の順番で巡回して S7 (IDLE) で停止しま
す。 

シングル書き込み波形を完了するために、以下の手順を行います。 

1. Single Write波形のタブをクリックします。 
2. 左の境界線から 1クロック サイクル後に WEN#トレースをクリックします。すると、アクション ポ
イントが置かれ、WEN#波形が作成されます。ステート 0 (s0) は自動的に生成され、1 IFCLKサイクル 
(20.83ns) 間持続します。  

3. GPIFが外部 FIFOに書き込んでいるため、REN#と OE#は、外部 FIFOがそのデータ バスを駆動しない
ように波形の間ずっと HIGHにアサートする必要があります。これを保証するために、OE#と REN#ト
レース上のアクション ポイントを右クリックして High (1)を選択します。波形が Figure 41のように
なります。 

 

 

Figure 41 1クロックの間 WEN#パルスが LOW 

4. データ バスは s0で駆動されます。このためには、データ アクション ポイントを右クリックして
Activate Dataを選択します。 

データ バスは 1クロック サイクルの間だけ駆動する必要があります。1クロック サイクル後にデータ
の駆動を停止するために、Dataバンドで最初のアクション ポイントから 1クロック後に別のアクシ
ョン ポイントを置きます。これで Dataバンドが s0の間だけ HIGHになることに注意してください。
波形が Figure 42のようになります。 
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Figure 42 S0中に 1クロックの間データを駆動 

5. Figure 43IDLEステートに戻る分岐を実装するために、決定点のステート S1を作成します。S0の右
の境界線で Statusバンドをクリックして、図 43のように無条件分岐を設定します。 

 

 

Figure 43 IDLEへの無条件分岐 

これで、シングル ワード書き込み波形が Figure 44のようになります。 
 

 

Figure 44 シングル ワード書き込み波形 
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9.2 シングル ワード書き込み波形 
読み出し波形は外部 FIFOから FX2LP INエンドポイント FIFOへのバイト転送を管理します。書き込み波
形と同様に、GPIF波形は外部 FIFOのタイミング要件を満たす必要があります。まず、外部 FIFOの読み
出しサイクル タイミングを確認して、シングル ワード読み出しのステート マシンを作成します。
Figure 45は、最下部に GPIFステートを追加した CY7C4265の読み出しタイミング図を示します。 
 

S0 S1 S2 IDLE

 

Figure 45 読み出しサイクルのタイミング図 

タイミング情報から Figure 46のバイト読み出しトランザクション用のステート マシンを構成できま
す。 
 

S0
WEN#=1
REN#=0
OE#=1

S1
WEN#=1
REN#=1
OE#=0

 S7(IDLE)
WEN#=1
REN#=1
OE#=1

Initiate

S2
WEN#=1
REN#=1
OE#=0

Activate Data

 

Figure 46 バイト読み出しのステート図 
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• シングル読み出し波形では、REN#は S0で 1 IFCLKサイクルの間論理 LOWになります。これは、デー
タシートに記載されている OE#アサート前の外部 FIFOの tENSセットアップ時間の理由です。それか
ら 1クロック後に REN#をデアサートすることで、FIFOが読み出し動作用にもう 1ワード増加しない
ようにします。 

• その後、S1は OE#をアサートして S2に遷移します。 
• 分岐する必要があるため、S2は決定点のステートとなります。S1の始まりではデータがまだ外部

FIFOに存在していないため、GPIFは S2の始まりでデータをサンプリングします。  
• シングル読み出し波形が開始されるたびに、GPIFエンジンは S0、S1、S2、S7の順番で巡回します。  

シングル読み出し波形を作成するために、以下の手順を行います。 

1. Single Read波形のタブをクリックします。 
2. REN#トレース上の最初のクロックを右クリックして Low (0)を選択します。左の境界線から 1クロッ
ク サイクル後に REN#トレースをクリックします。すると、アクション点が置かれ、REN#パルスが作
成されます。ステート 0 (s0) は自動的に生成され、1 IFCLKサイクル (20.83ns) 間持続します。従っ
て、REN#は 20.83ns間アサートされます (Figure 47)。 

 

 

Figure 47 REN#が 1クロックの間アサート 

3. OE#バンドで、S0の右の境界線にアクション点を置き、それから 1クロック後にもう 1つのアクショ
ン点を置きます。すると、OE#が S0の後にデアサートされ、1 IFCLKサイクル (20.83ns) 間持続するス
テート S1が作成されます。  
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Figure 48 OE#が 1クロックの間アサート 

4. Statusバンドで s1の終わりに対応したクロックをクリックして決定点 (DP) のステートを追加しま
す。すると、S2が作成され、「Specify Decision Point」ダイアログ ボックスが表示されます。決定点
を Figure 49のように設定して IDLEステートに無条件に分岐します。波形が Figure 50のようになり
ます。 

 

 

Figure 49 IDLEへの無条件分岐 
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Figure 50 ステート s2を追加 

5. 最後に、もう 1つの調整を行わなければなりません。データは S2の間にサンプリングする (読み出
す) 必要があります。データをサンプリングするために、Dataバンドで S2の始まりと終わりにアク
ション点を置きます。これが「Single Read」タブであるため、HIGHレベルが Dataバンドの制御より
はむしろサンプリングに対応します。最終のシングル ワードの読み出し波形は Figure 51のようにな
ります。 

6. 通常、GPIF Designerプロジェクト ファイル (*.gpf) および生成された Cファイルを Keilプロジェクト 
フォルダに保存する必要があります。この場合、それらは本アプリケーション ノートのコードの一
部として Keilプロジェクト フォルダに置いてあります。  

 

 

Figure 51 最終のシングル ワードの読み出し波形 

9.3 GPIFシングル トランザクション用のファームウェア プログラミング 
シングル ワードのトランザクション波形を GPIF Designerに実装した後、次の手順としては、USBファ
ームウェアを GPIF Designerの出力に組み込みます。これは、外部 FIFOへの書き込みと外部 FIFOからの
読み出しを USBを介して実行することを可能にします。既存のファームウェア フレームワーク プロジ
ェクトを開始し、GPIF管理コードを追加します。Keilプロジェクト ファイル FX2_to_extsyncFIFO.uv2を
ダブルクリックします。ファイルが開くと、「Files」パネルが Figure 52のように表示されます。Table 
2はこれらのファイルを説明します。  
 

 

Figure 52 「FX2_to_extsyncFIFO」プロジェクト ファイル 
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ファイル名 periph.cは FX2_to_extsyncFIFO.cに変更されました。このファイルでは、USBエンドポイント
と GPIF初期化コードを TD_Init()関数に追加し、GPIF管理コードを TD_Poll()関数に追加します。 

Table 2 プロジェクト ファイルの説明 

ファイル 説明 
fw.c USB要求を処理し、タスク ディスパッチャ TD_Poll() を呼び出すファームウ

ェア フレームワーク 
Ezusb.lib サスペンド、再開、I2C動作などを処理する関数の集合 
USBJmpTb.OBJ USB (INT2) と GPIF/スレーブ FIFO (INT4) 割り込みソースの割り込みベクタ ジ

ャンプ テーブル 
Dscr.a51 EP2OUTと EP6INを FX2LPデバイスの使用可能なエンドポイントとして報告

する、FIFO実施例のデバイス ディスクリプタ テーブル 
FX2_to_extsyncFIFO.c 
(periph.cから改名) 

TD_Poll()と TD_Init()を含んでいる主なユーザー アプリケーション コード。
fw.cを更新せず、このファイルを修正する必要 

Gpif.c シングル/FIFO GPIFトランザクション波形動作を実装する GPIF波形ディスク
リプタ テーブルを含んでいるファイル。これは GPIF Designerツールからエ
クスポートされた Cファイル  

9.4 コード スニペット 

9.4.1 TD_Init()  
TD_INIT()は以下のことを行いします。 

• CPUクロック周波数を 48MHzに切り替える (電源投入時のデフォルトクロックは 12MHz) 
• EP2をバルク OUTエンドポイント (サイズ 512の 4重バッファリング) に設定する 
• EP6をバルク INエンドポイント (サイズ 512の 4重バッファリング) に設定する 
• FIFOを手動モード、ワード幅動作に設定する 
• FIFORESETレジスタを使用してエンドポイントをリセットし、USBホスト (PC) からデータを受け入
れられるように EP2 OUTエンドポイントを有効にする 

void TD_Init(void)             // Called once at startup 
{ 
   // set the CPU clock to 48MHz 
      CPUCS = ((CPUCS & ~bmCLKSPD) | bmCLKSPD1); 
      SYNCDELAY; 
 
      EP2CFG = 0xA0;     // EP2OUT, bulk, size 512, 4x buffered 
      SYNCDELAY;                     
      EP4CFG = 0x00;     // EP4 not valid 
      SYNCDELAY;                     
      EP6CFG = 0xE0;     // EP6IN, bulk, size 512, 4x buffered 
      SYNCDELAY;                     
      EP8CFG = 0x00;     // EP8 not valid 
      SYNCDELAY; 
 
      EP2FIFOCFG = 0x01; // manual mode, disable PKTEND zero length send, 
word ops 
      SYNCDELAY; 
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      EP6FIFOCFG = 0x01; // manual mode, disable PKTEND zero length send, 
word ops 
      SYNCDELAY; 
 
      FIFORESET = 0x80;  // set NAKALL bit to NAK all transfers from host 
      SYNCDELAY; 
      FIFORESET = 0x02;  // reset EP2 FIFO 
      SYNCDELAY; 
      FIFORESET = 0x06;  // reset EP6 FIFO 
      SYNCDELAY; 
      FIFORESET = 0x00;  // clear NAKALL bit to resume normal operation 
      SYNCDELAY; 
 
   // out endpoints do not come up armed 
   //because EP2OUT is quad buffered, write dummy byte counts four times 
 
      EP2BCL = 0x80;     // arm EP2OUT by writing byte count w/skip. 
      SYNCDELAY;                     
      EP2BCL = 0x80; 
      SYNCDELAY;                     
      EP2BCL = 0x80; 
      SYNCDELAY; 
      EP2BCL = 0x80; 
      SYNCDELAY; 
 
  GpifInit (); // initialize GPIF registers 

• 次に、TD_Init は gpif.cに存在する関数 GPIFInit() を呼び出します。  
• GPIFInit()は GPIF波形ディスクリプタ テーブルを内蔵メモリにロードし、他の GPIFレジスタを設定
します。 

• どの時点においても、4つの波形だけをロードすることができます。4本以上の波形が物理インター
フェースの動作を記述するのに必要となる場合、別の 4本の波形の組を手動でロードしなければな
りません。  

• IFCONFIGレジスタは物理インターフェースを定義する GpifInit()内で設定されます。 
• TD_Init()は以下のコード スニペットに示すように PA2 (RS#) にパルスを発生させることで外部 FIFOを
リセットします。これにより、データ操作を開始する前に外部 FIFOが初期化されたことを保証しま
す。  

// reset the external FIFO 
 
  OEA |= 0x04;     // turn on PA2 as output pin 
  IOA |= 0x04;     // pull PA2 high initially    
  IOA &= 0xFB;     // bring PA2 low 
  EZUSB_Delay (1); // keep PA2 low for ~1ms, more than enough time 
  IOA |= 0x04;     // bring PA2 high    

• USBベンダー コマンド 0xB2は以下のコードで定義します。これにより、ホスト PCがベンダー コマ
ンドを発行することで外部 FIFOをリセットすることが可能になります。 

BOOL DR_VendorCmnd(void) 
{ 
switch (SETUPDAT[1]) 
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  { 
case VX_B2: 
    {  
// reset the external FIFO 
 
      OEA |= 0x04;     // turn on PA2 as output pin 
      IOA |= 0x04;     // pull PA2 high initially    
      IOA &= 0xFB;     // bring PA2 low 
      EZUSB_Delay (1); // keep PA2 low for ~1ms, more than enough time 
      IOA |= 0x04;     // bring PA2 high 
 
      *EP0BUF = VX_B2; 
   EP0BCH = 0; 
   EP0BCL = 1;         // Arm endpoint with # bytes to transfer 
   EP0CS |= bmHSNAK;   // Acknowledge handshake phase of device request 
break; 
    } 

9.4.2 GPIFシングル ワードの書き込みトランザクションをトリガー 
• 8051は XGPIFSGLDATH、XGPIFSGLDATLX、XGPIFSGLDATLNOXレジスタにアクセスすることで、シン
グル ワード読み出し／シングル ワード書き込みの GPIF波形をトリガーします。これはデータ転送を
開始します。 

• GPIFシングル ワードの書き込みトランザクションをトリガーするために、以下のように
XGPIFSGLDATHと XGPIFSGLDATLXに書き込みます: 

XGPIFSGLDATH = <word_value>>> 8; 
XGPIFSGLDATLX = <word_value> ;  // trigger GPIF Single Word Write transaction 

• これは転送されるワード値の MSBと LSBを設定し、XGPIFSGLDATLXレジスタへの書き込みはシング
ル ワードの書き込みトランザクションをトリガーします。 

• この例では、これは GPIF_SingleWordWrite() 関数内で行われます。この関数はワード値を入力引数と
して受け入れ、GPIFシングル ワードの書き込みトランザクションをトリガーします。 

void GPIF_SingleWordWrite( WORD gdata ) 
{ 
while( !( GPIFTRIG & 0x80 ) )  // poll GPIFTRIG.7 Done bit 
  { 
    ; 
  } 
 
// using registers in XDATA space 
  XGPIFSGLDATH = gdata;               
  XGPIFSGLDATLX = gdata >> 8;         // trigger GPIF Single Word Write 
transaction 
} 

• この関数は GPIFTRIG.7ビットをポーリングすることで、トランザクションを起動する前に GPIFが
IDLEステートにあるかどうかを確認します (GPIFステート マシンが IDLEステートにある場合、この
ビットがセットされます)。どの GPIFトランザクションも起動する前に GPIFは IDLEステートである
ことが必要です。 
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• エンドポイント バッファが FIFOとして構成されてからの、シングル トランザクション レジスタへ
のアクセス手順に注意してください。この手順により、エンドポイント バッファの最初のバイトが
FD[7:0]に書き出され、2番目のバイトが FD[15:8] (リトル エンディアン形式) に書き出されることを保
証します。 

9.4.3 GPIFシングル読み出しトランザクションをトリガー  
• GPIFシングル ワード読み出しトランザクションをトリガーするために、XGPIFSGLDATXレジスタから
のダミー読み出しを行います。この読み出しでは、データが転送されず、GPIF波形のみが開始され
ます。GPIFの DONEビットをテストした後、8051は XGPIFSGLDATHと XGPIFSGLDATLNOXレジスタ内
のワード値を読み出します。  

• この例では、これは GPIF_SingleWordRead() 関数内で行われます。この関数はデスティネーション変
数用のワード ポインタを引数として受け入れ、GPIFシングル ワードの読み出しトランザクションを
行います。 

void GPIF_SingleWordRead( WORD xdata *gdata ) 
{ 
static BYTE g_data = 0x00;     // dummy variable 
 
while( !( GPIFTRIG & 0x80 ) )  // poll GPIFTRIG.7 Done bit 
  { 
     ; 
  } 
 
// using register in XDATA space 
  g_data = XGPIFSGLDATLX;        // dummy read to trigger GPIF  
// Single Word Read transaction 
 
while( !( GPIFTRIG & 0x80 ) )  // poll GPIFTRIG.7 Done bit 
  { 
     ; 
  } 
 
// using register(s) in XDATA space, retrieve word just read from ext. FIFO 
  *gdata = ( ( WORD )XGPIFSGLDATLNOX << 8 ) | ( WORD )XGPIFSGLDATH; 
} 

• この関数はまず、XGPIFSGLDATLXからダミー読み出しを行って GPIFシングル ワードの読み出しトラ
ンザクションをトリガーする前に GPIFが IDLEステートであることを確認します。その後、GPIFが
トランザクションを完了するのを待ってから、ワード値を格納しているレジスタを読み出します。 

9.4.4 TD_Poll()  
• 主なアプリケーション コードは、デバイスの動作中に繰り返して呼び出される TD_Poll() 関数内にあ
ります。 

• この関数により、GPIF_SingleWordWrite() と GPIF_SingleWordRead() 関数が呼び出されます。 
• GPIF_SingleWordWrite() はデータを EP2OUTから外部 FIFOに送信し、GPIF_SingleWordRead() はデータ
を外部 FIFOから EP6INに読み出します。 

• USB OUT転送を処理するコードは以下のようです。 

if(!(EP2468STAT & bmEP2EMPTY) && (EXTFIFONOTFULL)) 
  { 
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// if host sent data to EP2OUT AND external FIFO is not full, 
 
    Tcount = (EP2BCH << 8) + EP2BCL; // load transaction count with EP2 
byte count 
    Tcount /= 2;                     // divide by 2 for word wide 
transaction 
    Source = (WORD *)(&EP2FIFOBUF); 
for( i = 0x0000; i < Tcount; i++ ) 
    { 
// transfer data from EP2OUT buffer to external FIFO 
      GPIF_SingleWordWrite (*Source); 
      Source++; 
    } 
    EP2BCL = 0x80; // re-arm EP2OUT 
  } 

• EP2空フラグは EP2468STATレジスタで確認され、EP2OUTに USBホストからのデータがあるかどう
かを判断します。 

• また、外部 FIFOからの FF#フラグは GPIFREADYSTATレジスタにアクセスして確認されます。これに
より、外部 FIFOには EP2OUTから外部 FIFOへ転送されるデータ用の空き容量があることを保証しま
す。8051は、GPIFREADYSTATレジスタにアクセスして GPIF RDY信号ステートを確認します。
EXTFIFONOTFULLは、bmBIT1と ANDされた GPIFREADYSTATのマクロです。 

• EP2OUTエンドポイントにデータがあり、外部 FIFOが満杯になっていない場合、ワード変数 Tcount
はカウント値で初期化されます。ホストから EP2OUTに転送されるバイト数は EP2BCH/Lレジスタに
アクセスして確認します。各 GPIFシングル ワード書き込みトランザクションが外部 FIFOに 1ワー
ドを送信するため、トランザクション数は実際にエンドポイント バッファに格納されているバイト
数の半分となります。  

• 次に、「for」ループ GPIF_SingleWordWrite関数を「Tcount」回呼び出し、エンドポイント バッファ
EP2の値を 1つずつ読み出して外部 FIFOに 1度に 1データ ワードを送信します。各ループは 1つの
GPIFシングル書き込みトランザクションをトリガーして、外部 FIFOに 1回に 1データ ワードを送信
します。 

• 「Tcount」のデータ ワードを送信した後、ホストからの USBデータ パケットが受け入れられるよう
に EP2エンドポイントを再び有効にします。FX2LPは新しいパケットを受け入れられるまで自動的に
すべての OUTパケットを NAKします。このため、ホストは OUT転送を実行しようとし続けます。  

• USB IN転送を処理するコードは以下のようです。 

if(in_enable) // if IN transfers are enabled, 
  { 
if(!(EP2468STAT & bmEP6FULL) && (EXTFIFONOTEMPTY)) 
    { 
// if EP6IN is not full AND there is data in the external FIFO, 
 
      Destination = (WORD *)(&EP6FIFOBUF); 
for( i = 0x0000; i < Tcount; i++ ) 
      { 
// transfer data from external FIFO to EP6IN buffer 
        GPIF_SingleWordRead (Destination); 
        Destination++; 
      } 
        Tcount *= 2;          // multiply by 2 to obtain byte count value     
      EP6BCH = MSB(Tcount);   
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      SYNCDELAY;   
      EP6BCL = LSB(Tcount); // arm EP6IN to send data to the host 
      SYNCDELAY;                     
    } 
  } 

• in_enableフラグが TRUEの場合、EP6INエンドポイント バッファが満杯になっていない、かつ外部
FIFOが空でないことを保証するために確認します (EXTFIFONOTEMPTYは GPIFREADYSTATと bmBIT0
のマクロです)。  

• EP6INエンドポイント バッファが満杯になっていなく、外部 FIFOが空でない場合、「for」ループは
GPIF_SingleWordRead() 関数を呼び出します。これは、1つの GPIFワード読み出しをトリガーし、
EP6IN FIFO用に設定されたデスティネーション アドレスに結果を格納します。ループが繰り返され
るたびに、デスティネーション アドレスがインクリメントされ、EP6IN FIFOが外部 FIFOから読み出
されたワードで満杯になります。  

• EP6IN FIFOが外部 FIFOデータで満杯になった後、8051はデータをホスト PCに転送するために EP6IN
エンドポイントを有効にします。有効にされる前に、EP6へのすべてのホスト IN要求は自動的に
FX2LP USBロジックによって NAKされます。8051は、ホスト IN転送で転送するバイト数を示すバイ
ト カウントを書き込むことで INエンドポイントを準備します。各 GPIFシングル ワード読み出しト
ランザクションは外部 FIFOから完全な 1ワード (2バイト) を受信するため、ホストに送信されるバ
イト数は GPIFトランザクション数の 2倍となります。  

• IN転送は、「in_enable」フラグに適切な値を割り当てることで有効または無効にします。以下のコ
ードに示すように、この例で 2つのベンダー コマンドを定義します: IN転送を有効にするものと IN
転送を無効にするもの。 

case VX_B3: // enable IN transfers 
      { 
        in_enable = TRUE; 
      *EP0BUF = VX_B3; 
        EP0BCH = 0; 
        EP0BCL = 1; 
        EP0CS |= bmHSNAK; 
      break; 
    } 
      case VX_B4: // disable IN transfers 
      { 
        in_enable = FALSE; 
      *EP0BUF = VX_B4; 
        EP0BCH = 0; 
        EP0BCL = 1; 
        EP0CS |= bmHSNAK; 
      break; 
    } 

• INベンダー コマンド 0xB3は、in_enableを TRUEにセットすることで IN転送を有効にするように定
義されています。 

• INベンダー コマンド 0xB4は、in_enableを FALSEにセットすることで IN転送を無効にするように定
義されています。 

• in_enableの初期設定値は FALSEです。 
• in_enable フラグを使うことで、読み取りと書き込みを独立してテストすることができます。常に有
効になっている場合、IN転送コードは OUT転送コードの直後に処理されます。コードを 1行ずつ進
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めることで、デバッグ処理用のロジック アナライザを使用して各読み出し／書き込み動作を取り込
むことができます。 

9.5 サンプル GPIFシングル トランザクションの実行 

9.5.1 外部 FIFOなし 
外部 FIFOを内蔵した FX2LP開発基板アドオンをビルドしない場合でも、オシロスコープで GPIFの書き
込み転送を観察することができます。これは、データを PCから FX2LPチップにパイプを介して転送す
る USBコードおよび外部 FIFOにデータを出力する GPIF波形を検証します。  

1. FX2LP開発基板の P2～11をプローブして CTL0=WEN#を観察し、P1～19をプローブして FIFOデータ 
バス D0を観察します。  

2. 上記のように USBコントロール センターを起動します。FX2LP開発基板を PCポートに差し込みま
す。すると、基板が Figure 21のように USBローダ デバイスとしてエニュメレートします。そうで
ばい場合は、Figure 21になるために手順に従います。 

3. Program FX2 > RAMを選択し、FX2_to_extsyncFIFO.hexファイルに移動してそれをロードします。  
4. Bulkloopデバイスを拡張して Bulk out endpoint (0x02) を選択します。  
5. Figure 53に示すように数字を Data to send (Hex)テキスト ボックスに入力します。  
6. Transfer Data-OUTボタンをクリックします。  
 

 

Figure 53 USBコントロール センターはデータを転送 

7. 右下隅のテキスト ウィンドウは転送を確認し、スコープは WEN#パルスのネガティブ エッジでトリ
ガーします (Figure 54)。  

 

 

Figure 54 最上部: WEN#、最下部: FD[0] 
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最初の FIFO書き込み転送は FD[0]が HIGHであり、2番目のものは FD[0]が LOWであることに注意してく
ださい。これにより、16ビット ワードが L-Hの順番で出力されることを保証します: 最初のワードは
0001、2番目のワードは 0100です。 

9.5.2 外部 FIFOあり 
外部 FIFO基板のファームウェアをビルドして基板を差し込んだ後、ループバックをテストするため
に、まず前節で説明したようにデータに対し USBOUT転送を行います。次に、同じバイト数で Data-IN
の転送を行います。このテストでは、512データ バイトを持っている 512_count.hexを使用します。 

1. ツリー図で Bulk out endpoint (0x02)を選択します。Data Transfersタブをクリックします。Transfer 
File-OUTボタンを押し、Keilプロジェクト フォルダ (FX2LP Source code and GPIF project 
files\Firmware\FX2_to_extsync FIFO GPIF Single Transactions) で 512_count.hexを選択します。Openを
クリックします。すると、512バイトが外部 FIFOに送信されます。  

2. IN転送を使用して 512バイトを外部 FIFOから読み戻すために、USBベンダー要求を使って in_enable
フラグを TRUEにセットする必要があります。ツリー図で Control endpoint (0x00)を選択し、Req 
codeフィールドに「0xB3」を入力します。Req Typeを「Vendor」、Directionを「In」、Bytes to 
Transferを「1」にセットします。Transfer Dataをクリックします。 

3. ツリー図で Bulk in endpoint (0x86)を選択します。Bytes to Transfer内のバイト数が 512であること
を確認します。Transfer Data-INボタンを押します。これで、同じ 512データ バイトが FIFOが読み
戻されるはずです。 

9.6 シングル トランザクション用のロジック アナライザ波形 
本節は、GPIF Designerで定義された、波形用の GPIFエンジンによって生成されたタイミングを示しま
す。  

9.6.1 シングル ワード書き込み波形 
 

 

Figure 55 シングル ワード書き込み波形 

Figure 55は、GPIF Designerで定義された、シングル書き込み波形用の GPIFエンジンによって生成され
たタイミング信号を示します。GSTATE [2:0]を含むすべての信号はここに表示されています。GSTATE 
[2:0]は、シングル書き込みトランザクションを実行する時に経る GPIFエンジンのステートを示します。  
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デバッグのヒント:  
• ロジック アナライザ ヘッダに GSTATE信号を引き出すことで、GPIF Designer波形と物理インターフ
ェースで生成された信号がマッチするかを確認することができます。これは、ステート遷移が正し
いかどうかを検証できるため、デバッグ処理プロセスも支援します。 

• S0はバスにデータを配置し (PORTBは FD[7:0]、PORTDは FD[15:8])、(外部 FIFOの WEN#ラインに接続
された) CTL0をアサートします。すると、16ビットのデータ値が外部 FIFOに書き込まれます。 

• 外部 FIFOの最小データ セットアップ時間は 4ns (CY7C4265データシートを参照) であるため、IFCLK
の立ち上がりエッジまでのデータ セットアップ時間が十分に提供されていることに注意してくださ
い。 

• S1は、無条件に IDLEステートへ分岐してトランザクションを終了する決定点のステートです。  
• 無条件分岐を使わないと、GPIFエンジンは IDLEステート (S7) に達するまで、残りのステート (S2～

S6) を順番に遷移してきます。  
• バルク OUT転送で書き出すすべてのワードで、S0、S1、S7を巡回する GPIFエンジン サイクルが表
示されます。  

• 波形を捕捉するためには、CTL0の立ち下がりエッジでロジック アナライザをトリガーします。  
• 4nsのサンプリング レートで、Figure 55の波形に示したものと同じ分解能が得られます。 

9.6.2 シングル ワード読み出し波形 
 

 

Figure 56 シングル ワード読み出し波形 

Figure 56は、GPIF Designerで定義された、シングル ワード読み出し波形用の GPIFエンジンによって生
成されたタイミングを示します。GSTATE [2:0]を含むすべての信号はここに表示されています。GSTATE 
[2:0]は、シングル読み出しトランザクションを実行する時に経る GPIFエンジンのステートを示します。  

デバッグのヒント:  
• S0は (外部 FIFOの REN#ラインに接続された) CTL1をアサートし、S1は (外部 FIFOの OE#ラインに接
続された) CTL2 をアサートし、S2はデータ バス (PORTBは FD [7:0]、PORTDは FD[15:8]) をサンプリン
グします。すると、16ビットのデータ値が外部 FIFOから読み出されます。  

• GPIFの最小データ セットアップ時間が 9.2ns (FX2LPデータシートを参照) であるため、IFCLKの立ち
上がりエッジまでのデータ セットアップ時間が十分に提供されていることに注意してください。  

• S2は、無条件に IDLEステートへ分岐してトランザクションを終了する決定点のステートです。  
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• 無条件分岐を使わないと、GPIFエンジンは IDLEステート (S7) に達するまで、残りのステート (S3～
S6) を順番に遷移してきます。  

• バルク IN転送で外部 FIFOから読み出すすべてのワードで、S0、S1、S2、S7を巡回する GPIFエンジ
ン サイクルが表示されます。  

• 波形を捕捉するためには、CTL1の立ち下がりエッジでロジック アナライザをトリガーします。  
• 4nsのサンプリング レートで、Figure 56の波形に示したものと同じ分解能が得られます。 
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10 関連文書: 
• 「Getting Started with FX2LP」: この文書はユーザーが FX2LPに詳しくなる手助けになります。 
• 「FX2LP Technical Reference Manual」: この文書は FX2LPのテクニカル ガイドとなります。
「General Programmable Interface (GPIF)」章は GPIFを詳しく説明しています。 

• 「GPIF Designer Utility User Guide」: この文書にアクセスするためには、GPIF Designerからユーティ
リティをダウンロードします。インストール後、Help > This Toolを選択します。 

• 「EZ-USB FX1-EZ-USB FX2LP Development Kit Quick Start Guide.pdf」と「EZ-USB Development Kit User 
Guide.pdf」: これらの文書は CY3684キットの使用方法を説明しており、(DVKのインストール後に) 
C:\Cypress\USB\CY3684_EZ-USB_FX2LP_DVK\1.0\Documentation にあります。 

• 「Endpoint FIFO Architecture of EZ-USB FX1/FX2LP」: このアプリケーション ノートは FX1/FX2LP内
のデータ フローを理解する手助けになります。 

10.1 他の GPIF例 
他の GPIFの例は以下のサイプレスのアプリケーション ノートにあります。  

• 「AN57322: Interfacing SRAM with FX2LP over GPIF」: このアプリケーション ノートは GPIF 8ビット
非同期 (クロックなし) インターフェースを使用して CY7C1399B SRAMを FX2LPに接続する方法を説明
します。また、この文書は FX2LPを他の SRAMに接続するガイドとなります。  

• 「AN63787: EZ-USB FX2LP GPIF and Slave FIFO Configuration Examples Using 8-bit Asynchronous 
Interface: このアプリケーション ノートは、8ビット非同期パラレル インターフェースを実装するよ
うに EZ-USB FX2LPの GPIFとスレーブ FIFOを手動モードと自動モードの両方で設定する方法を説明
します。デザインは、2個の相互接続された FX2LP開発基板 (1個が GPIFマスターとして、もう 1個
が GPIFスレーブとして動作) を使用してテストします。  

• 「AN4051: FX2LP GPIF Flow State Feature for UDMA: このアプリケーション ノートは GPIFの「フロー 
ステート」機能を紹介します。この機能により、GPIF機能は ATAPI UDMAを処理できるように拡張さ
れます。 

10.2 リファレンス デザイン 
• 「CY4611B - USB 2.0 USB to ATA Reference Design」: 一般的な FX2LPの応用の 1つは USB大容量記憶
装置です。FX2LP GPIFにより、接続されたドライブとの切れ目のない接続を実現できます。サイプレ
スは、FX2LPを使った大容量記憶装置の参考設計を提供しています。 

10.3 データシート 
• 「EZ-USB FX2LP USB Microcontroller High-Speed USB Peripheral Controller」 
• CY7C4265データシート 

http://www.cypress.com/?rID=48371
http://www.cypress.com/?rID=38232
http://www.cypress.com/?rID=14448
http://www.cypress.com/?rID=12926
http://www.cypress.com/?rID=39392
http://www.cypress.com/?rID=45850
http://www.cypress.com/?rID=45850
http://www.cypress.com/?rID=12951
http://www.cypress.com/?rID=14406
http://www.cypress.com/?rID=38801
http://www.cypress.com/?rID=34595
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11 まとめ 
本アプリケーション ノートは EZ-USB FX2LP GPIFへの紹介資料となります。本書は、汎用プログラマブ
ル インターフェースを作成する手順を説明し、GPIF Designerの主な特長を示す例を提供します。 
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重要事項 
本文書に記載された情報は、いかなる場合も、
条件または特性の保証とみなされるものではあ
りません（「品質の保証」）。本文に記された
一切の事例、手引き、もしくは一般的価値、お
よび／または本製品の用途に関する一切の情報
に関し、インフィニオンテクノロジーズ（以
下、「インフィニオン」）はここに、第三者の
知的所有権の不侵害の保証を含むがこれに限ら
ず、あらゆる種類の一切の保証および責任を否
定いたします。 
 
さらに、本文書に記載された一切の情報は、お
客様の用途におけるお客様の製品およびインフ
ィニオン製品の一切の使用に関し、本文書に記
載された義務ならびに一切の関連する法的要
件、規範、および基準をお客様が遵守すること
を条件としています。 
 
本文書に含まれるデータは、技術的訓練を受け
た従業員のみを対象としています。本製品の対
象用途への適合性、およびこれら用途に関連し
て本文書に記載された製品情報の完全性につい
ての評価は、お客様の技術部門の責任にて実施
してください。 

 
本製品、技術、納品条件、および価格について
の詳しい情報は、インフィニオンの最寄りの営
業 所 ま で お 問 い 合 わ せ く だ さ い
(www.infineon.com)。 
 
警告事項 
技術的要件に伴い、製品には危険物質が含まれ
る可能性があります。当該種別の詳細について
は、インフィニオンの最寄りの営業所までお問
い合わせください。 
 
インフィニオンの正式代表者が署名した書面を
通じ、インフィニオンによる明示の承認が存在
する場合を除き、インフィニオンの製品は、当
該製品の障害またはその使用に関する一切の結
果が、合理的に人的傷害を招く恐れのある一切
の用途に使用することはできないこと予めご了
承ください。 
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